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SUMMARY

Nuclear pore complexes are pathways for nuclear-cytoplasmic communication
that participate in chromatin organization. Here, we present a protocol to image
and quantify the number of nuclear pore complexes in cells. We describe steps
for cell plating and culture, immunofluorescence detection, and confocal micro-
scopy visualization of nuclear pore complexes. We then detail quantification
and 3D data analysis. This protocol utilizes digital thresholding under human su-
pervision for quantification of nuclear pore complexes.
For complete details on the use and execution of this protocol, please refer to
Han et al.1

BEFORE YOU BEGIN

Nuclear pore complexes are pathways for nuclear-cytoplasmic communication and participate in

chromatin organization.2 Nuclear pore complexes consist of nucleoporins (Nups), which are ar-

ranged in eight-fold symmetry to form a hollow cylinder with approximately �120–180 nm outer

diameter. Widely available approaches for detection and visualization of nuclear pore complexes

are needed. We present a protocol utilizing immunofluorescence detection with confocal micro-

scopy visualization of nuclear pore complexes in conjunction with antibody-detection of cytoskeletal

structures for co-localization studies. The quantitative results of this protocol were cross-validated

with Stochastic Optical Reconstruction Microscopy (STORM) and freeze-fracture replica electron

microscopy.1

The use of immunofluorescence confocal microscopy1,3 has advantages over microscopy methods that

offer higher resolution. Freeze-fracture electron microscopy,4 the classical method for nuclear pore com-

plex quantification, requires specialized equipment and skills, and confocal microscopes aremorewidely

available than the equipment for freeze-fracture replica electronmicroscopy. Likewise, the equipment for

super-resolution light microscopy and, especially, for recently introduced lattice light-sheet microscopy5

to image nuclear pore complexes, is not as available as that for confocal light microscopy. Two, in terms

of imaging resolution, freeze-fracture electron microscopy and super-resolution light microscopy can

reveal the size of the nuclear pore complexes, but, at this point of development, their resolution cannot

reveal the inner molecular structure of nuclear pore complexes. As such, the resolution-advantage over

confocal microscopy is small. Three, immunofluorescence confocal microscopy offers to quantify nuclear

pore complexes in an entire nucleus. In contrast, freeze-fracture replica electronmicroscopy exposes only

parts of a nucleus, and the entire nucleus cannot be visualized.4 As such, confocal microscopy eliminates
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one possible source of bias, i.e., selection bias. Four, immunofluorescence confocal microscopy offers

the combination with multiple antibody markers,1,3 which enables more sophisticated experiments.

Combination with other imagingmethods or markers is not possible with freeze-fracture replica electron

microscopy because it images the replica of the tissue, i.e., the source tissue, including the epitopes for

antibody detection, are not present. Although super-resolution light microscopy can image in different

wavelengths, these applications are not as straight-forward aswith confocal microscopy. In summary, the

combined advantages of the presented confocal microscopy protocol over microscopy approaches with

higher resolution outweigh the disadvantages for the visualization and quantification of nuclear pore

complexes.

The presented protocol was designed for rat and mouse heart muscle cells (cardiomyocytes), and

human induced pluripotent stem cell-derived cardiomyocytes (hiPSCs), and for antibody-based co-

localization studies.1 However, this protocol could be combined with antibody-detection of

signaling molecules for nuclear import studies in any cell type.

Cell plating preparation

Timing: 1 h 15 min

1. Prepare 0.025 mg/mL of Human Fibronectin; Dissolve 1 mg of Human Fibronectin in 40 mL of

sterile 13 PBS. Pipet up and down gently to thoroughly dissolve. Aliquot and store in �80�C
freezer for up to 6 months.

2. Use sterile technique to place a 13 mm Thermanox coverslip into a well of a 24 well cell culture plate.

Alternatives:An ibidi optical polymer chamber or dish may be used in lieu of coverslips and 24

well plate.

3. Coat the coverslip or ibidi container with approximately 400 mL of sterile Human Fibronectin,

enough to cover the entire well. Incubate at 20�–25�C for at least 1 h prior to plating cells.

Note: This protocol uses treated Thermanox plastic coverslips for cell culture to improve the

adherence of cardiomyocytes and hiPSC’s. Traditional precleaned glass coverslips should be

used for other cell types when appropriate. It is suggested to modify the sample mount for

optimal light path properties for each application of this protocol.

Solution preparation for cell fixation and staining

Timing: 15 min

4. Prepare 4% paraformaldehyde Fixation Buffer: 4 mL 103 PBS + 10 mL 16% PFA + 26 mL water.

5. Prepare 0.5% Triton-X100 Permeabilization buffer: 250 mL Triton-X100 + 48.5 mL of 13 PBS.

6. Prepare 3% BSA Blocking solution: 1.5 g BSA (Bovine Serum Albumin) + 48.5 mL 13 PBS or 13 TBS.

KEY RESOURCES TABLE

REAGENT or RESOURCE SOURCE IDENTIFIER

Antibodies

Hoechst 33342, Trihydrochloride, Trihydrate – 10 mg/
mL solution in water (1:400-1:1000)

Invitrogen Cat# H3570
Lot#1860907;
RRID: N/A

(Continued on next page)
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Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

NUP Complex Protein Antibody Mab414 (1:400) Abcam Cat#; ab24609
Lot# GR-3235621-11
RRID:AB_ 448181

Anti-NUP98 mAb (1:200) Abcam Cat#; ab50610
Lot# GR3212026-6[
RRID:AB_ 881769

Anti-NUP107 polyclonal antibody (1-2 mg/mL)) Abcam Cat#; ab73290
Lot# GR6666-28
RRID:AB_1269604

Anti-NUP153 mAB (1:400-1:500) Abcam Cat#; ab24700
Lot# GR3177964-2
RRID:AB_2154467

Anti-NUP133 mAb (1:100 for IF 1:100-1:1000 WB) Santa Cruz Cat#; sc376763
Lot# E2317
RRID:AB_2889360

Anti-Cardiac Troponin I antibody (1:200- 1:400) Abcam Cat# ab56357;
Lot# GR313459-8
RRID:AB_880622

Donkey anti-Goat IgG (H + L) Cross-Adsorbed
Secondary Antibody, Alexa Fluor 647 (1:200-1:400)

Thermo Fisher Cat# A21447
Lot# 2045332
RRID: AB_141844

Donkey anti-Mouse IgG (H + L) Highly Cross-Adsorbed
Secondary Antibody, Alexa Fluor 488 (1:200-1:400)

Thermo Fisher Cat# A21202
Lot# 2018296
RRID: AB_141607

Donkey anti-Mouse IgG (H + L) Highly Cross-Adsorbed
Secondary Antibody, Alexa Fluor 568 (1:200-1:400)

Thermo Fisher Cat# A10037
Lot# 2110843
RRID: AB_2534013

Donkey anti-Mouse IgG (H + L) Highly Cross-Adsorbed
Secondary Antibody, Alexa Fluor 594 (1:200-1:400)

Thermo Fisher Cat# A21203
Lot# 1722995
RRID: AB_141633

Donkey anti-Rabbit IgG (H + L) Highly Cross-Adsorbed
Secondary Antibody, Alexa Fluor 488
(1:200-1:400)

Thermo Fisher Cat# A21206
Lot# 2072687
RRID: AB_2535792

Donkey Anti-Rabbit IgG H&L (Alexa Fluor 555) (1:200-
1:400)

Abcam Cat# ab150074
Lot# GR3241278-3
RRID: AB_2636997

Donkey anti-Rat IgG (H + L) Highly Cross-Adsorbed
Secondary Antibody, Alexa Fluor 488 (1:200-1:400)

Thermo Fisher Cat# A21208
Lot# 2482958
RRID: AB_2535794

Anti-rat IgG (H + L) Highly Cross-Adsorbed, CF 568
antibody produced in donkey (1:200-1:400)

Sigma Cat# SAB4600077
Lot# 21C0715
RRID: AB_2827516

Software and algorithms

Nikon NIS Elements 4.5 software Nikon Instruments (https://www.microscope.healthcare.nikon.com/
products/software/nis-elements/viewer

Fiji (ImageJ) Fiji open source software https://imagej.net/software/fiji/downloads

GraphPad Prism 7 GraphPad Software N/A

Other

Electron Microscopy Science Company (EMS) 16%
paraformaldehyde

Fisher Scientific 50-980-487

Gibco Antimycotic-Antibiotic 1003 Fisher Scientific 15-240-062

Gibco PBS (13) pH7.4 Thermo Fisher 10010023

Gibco PBS (103) pH7.4 Thermo Fisher 70011044

FBS USDA qualified Fisher Scientific 10437028

DMEM media, high glucose w/o L-glut Fisher Scientific 11960044

Bovine serum albumin (BSA) Fisher Scientific BP9706-100

Glycerol Sigma G5516-1L

Triton X-100 Fisher BP151-500

(Continued on next page)
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MATERIALS AND EQUIPMENT

All media and solutions used for culturing cells should be prepared using sterile equipment under a

biohazard cabinet.

Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

Propyl gallate (NPG) Sigma 02370

Ibidi USA m-Dish 35 mm, High, ibiTreat - Tissue Culture
Treated Polymer Coverslip

Fisher 50-305-806

Corning Centrifuge Tube Top Vacuum Filters 50 mL Fisher Scientific Cat. # 09-761-34

Corning Falcon Polystyrene microplates, 24 well Fisher Scientific Cat. # 08-772-1

Nunc Thermanox Coverslips, 13 mm Thermo Fisher Scientific Cat. # 174950

Colorfrost Precleaned Microscope slides Fisher Scientific Cat. # 12-550-43

Corning Cover glass, 22 3 22 mm, thickness #1.5 Fisher Scientific Cat. # 12-553-454

High Viscosity Cargille Immersion Oil Type B Fisher Scientific Cat. # 12-369A

Human fibronectin Fisher Scientific Cat# CB40008

Nikon A1R scanning laser confocal microscope (Body:
Nikon Ti Eclipse - inverted, Confocal unit: Nikon A1R
HD)

Nikon NA

Piezo motorized stage Mad City Labs 100 mm
NanoDrive piezo, 0.2 nm resolution

Nikon NA

Stage Nikon Ti-S-ER motorized x,y, stage linearly
encoded

Nikon NA

Z direction scanner; Ti Z drive Nikon NA

Illumination light ssource: LED Illumination X-Cite 120
Solid State lasers:
405 nm (DAPI)
488 nm (FITC)
561 nm (TRITC)
640 nm (CY5)

Nikon NA

Laser scanning confocal unit Nikon A1R HD Galvano
scanner
Laser power of 15 mW at fiber tip

Nikon NA

Objective lenses
103: Plan Apo 0.45 NA, 4.0 mm WD
203: Plan Apo VC 0.75 NA, 1.0 mm WD
403 oil: Plan Fluor 1.30 NA, 0.20 mm WD
603 oil: Plan Apo Lambda 1.40 NA, 0.13 mm WD
1003 oil: Plan Apo Lambda 1.45NA, 0.13 mm

Nikon NA

Wavelength selection
Dichroic mirror for excitation and emission

Nikon NA

Acquisition Software: Nikon Elements version 5.41.02,
64bit

Nikon NA

Detector (confocal):
A1-DUG multi detector with GaASP
DAPI: PMT
FITC: GaAsP
TRITC:GaAsP
Cy5: PMT

Nikon NA

Acquisition mode: Laser scanning Nikon NA

Scan Mechanism: Galvano Nikon NA

Fibronectin

Reagent Final Concentration Amount

Sterile 13 PBS N/A 40 mL

Human Fibronectin N/A 1 mg

TOTAL N/A 40 mL

Gently pipet up and down until all traces of powder are dissolved. Aliquot and store at �80�C for up to 6 months.
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Note: Rock at 20–25�C at a speed of 2.5–3 rpm and a tilt of 10 for 24–48 hrs. until no visible

trace of white powder.

STEP-BY-STEP METHOD DETAILS

Part 1: Cell plating and culture

Timing: 16–24 h

Part 1 of this protocol describes optimal seeding and culturing of cells to ensure proper distribution

for clear imaging.

Culture Media

Reagent Final Concentration Amount

Dulbecco’s Modified Eagle Medium (DMEM), high
glucose w/o L-glut

N/A 44.5 mL

Fetal bovine serum (FBS), USDA qualified 10% 5 mL

Gibco Antibiotic-Antimycotic 1003 1% 500 mL

TOTAL N/A 50 mL

Sterilize using a 0.22 mm bottle top vacuum filter and store at 4�C for a month.

Fixation Buffer (4% PFA)

Reagent Final Concentration Amount

EMS 16% paraformaldehyde Aqueous solution 4% 10 mL

PBS 103 13 4 mL

MiliQ or deionized water N/A 26 mL

TOTAL N/A 40 mL

Store at 4�C for up to 6 months

Permeabilization Buffer

Reagent Final Concentration Amount

PBS 13 50 mL

Triton X-100 0.5% 250 mL

TOTAL N/A 50 mL

Store at 20–25�C for up to 1 year.

Blocking Buffer

Reagent Final Concentration Amount

PBS 13 50 mL

Bovine Serum Albumin, DNase and Protease-free 3% 1.5 g

TOTAL N/A 50 mL

Store at 4�C for up to 6 months.

Mounting Media

Reagent Final Concentration Amount

Glycerol N/A 50 mL

N-Propyl gallate (NPG) 1% 0.5 g

TOTAL N/A 50 mL

Store at 4�C for up to 1 year.
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1. Remove fibronectin from each well containing a Thermanox plastic coverslip (or ibidi optical poly-

mer dish or chamber) using a p1000 pipette or aspiration system.

2. Plate an appropriate number of cells per coverslip to achieve 80–90% confluency at time of fixa-

tion. Add approximately 400–500 mL of culture media to each well, so that the cells are

completely covered to prevent drying out.

Note: The number of cells needed to achieve the proper confluency is dependent upon cell

line and length of cell culture

CRITICAL: Make certain to plate cells at a density that will not cause overcrowding. Cells

should be a monolayer at time of fixation.

3. Place the plate in a 37�C 5% CO2 incubator and incubate 16–24 h.

4. The following morning, remove media and add approximately 500 mL of sterile 13 PBS to each

well.

5. Gently rinse the cells by running PBS over the coverslip to remove any dead or unattached cells.

CRITICAL: Take care not to disturb attached cells.

6. Remove PBS and add 500 mL of culture media. Continue to incubate cells until ready for fixation.

Note: If cells need to be treated, after PBS wash, add appropriate culturemedia with reagents.

Continue to incubate cells in the incubator until intended length of cell treatment is

concluded.

Part 2: Staining

Timing: 18–24 h

Part 2 of this protocol describes the steps for fixing and staining cells and nuclei for nuclear pore

quantification.

7. Remove culture media from cells and wash with 13 PBS. Fix cells in �500 mL 4% paraformalde-

hyde for 20 min at 20–25�C.
8. Wash cells 3 times with 13 PBS.

Note: Fixation time can be optimized for each user with other cell types for best results.

Alternatives: Cells can be fixed in 100% methanol (MeOH) at �20�C for 10 min followed by

washing 3 times with 13 PBS. However, it is recommended that fixations be optimized for

each cell type and antibody since not all antibodies will work with MeOH.

Note: Cells can be store for several months in PBS at 4�C. However, for best results it is rec-
ommended they be stained within 4 weeks.

9. Remove PBS from previously fixed cells and permeabilize with �500 mL of 0.5% Triton-X 100 to

completely cover the cells. Incubate for 10 min at 20–25�C.
10. Wash cells one time with 13 PBS and block by adding �500 mL blocking buffer. Incubate for 2 h

at 20–25�C.
11. While blocking, prepare primary antibody master mix.

a. Dilute primary antibody in blocking buffer using manufacturers recommended dilution.

b. Calculate a minimum of 400–500 mL per well. If using more than one primary antibody, dilute

all antibodies in the same buffer solution to intended concentration.
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c. Store at 4�C until ready to use.

12. After 2 h, remove blocking buffer and add diluted primary antibody mixture to each well. Incu-

bate at 4�C for 16–24 h.

Alternatives: Add� 100 mL of diluted antibody to the coverslip and cover with a small piece of

parafilm to prevent evaporation and drying.

Note: Mab414 (1:400 dilution) (Abcam, ab24609) is used in this example to stain nuclear

pores. Many research papers have used monoclonal antibody (Mab414) for detection of nu-

clear pore complexes. This antibody recognizes the nucleoporins, Nup62, Nup153, and

Nup358. Because the Mab414 antibody is commonly used in published studies, we have uti-

lized it in this protocol. However, we have achieved acceptable confocal microscopy images

also with a monoclonal Nup98 antibody.

13. The following morning, remove primary antibody and wash cells in 13 PBS and rock for 5 min at

20–25�C. Repeat wash for a total of 3 times.

14. While washing cells, dilute secondary antibody in 13 PBS according to manufacturer’s recom-

mended dilution.

Note: If using more than one secondary antibody, dilute all antibodies in the same 13 PBS

buffer solution as done in step 11.

15. Remove third PBS wash and add 400–500 mL of secondary antibody solution to each well. Incu-

bate the cells at 20–25�C in the dark for 2 h.

Alternatives: Add� 100 mL of diluted antibody to the coverslip and cover with a small piece of

parafilm to prevent evaporation and drying.

CRITICAL: Be sure plate is stored in complete darkness, either in a drawer or covered with

aluminum foil.

16. After 2 h, remove secondary antibody and wash cells 3 times in 13 PBS for 5 min as in step 13.

17. Dilute Hoechst in 13 PBS at approximately 1:500–1:1000 or optimize according to manufac-

turer’s recommendation.

a. incubate at 20–25�C in the dark for 5 min.

b. Wash briefly in 13 PBS.

18. Using fine-tipped forceps, carefully remove coverslip from the well, taking care not to flip the

coverslip or scratch cells from surface of the coverslip (Figure 1A).

19. Mount coverslip onto a precleaned microscope slide with cells facing up between two thin strips

of pre-cut parafilm (Figure 1B).

Note: Slides may be cleaned with a Kimwipe and 100% Ethanol to remove dust or lint prior to

mounting.

Note: The two parafilm strips act as spacers to avoid pressing cells and damaging cell

morphology.

The parafilm strips (approx. 2 mm3 15mm) should be cut and placed on the microscope slide

prior to placing coverslip to avoid drying out the cells. Take care to place the strips apart far

enough to fit a 13 mm round coverslip, but still within the range of cover by the square cover-

slip (22 mm wide) that is to be mounted on top.

ll
OPEN ACCESS

STAR Protocols 4, 102552, September 15, 2023 7

Protocol



20. Add 1 drop (approx. 25 mL) of mounting media and cover the cells with 22 mm 3 22 mm glass

coverslip #1.5, allowing themedia to cover the cells while avoiding bubbles (Figures 1C and 1D).

21. Seal the edges of the glass coverslip with fingernail polish. Allow to dry before imaging.

(Figures 1E and 1F).

Note: In the presented protocol, special consideration was given to the sample mounting

(shown in Figure 2). In the design/development of the sample mounting part of our protocol,

we had to consider the following: (1) Optimal attachment of cardiomyocytes requires growth

on plastic. To this end, we have seeded cardiomyocytes on round Thermanox coverslips. So as

not to distort the light path with the plastic Thermanox coverslips, we have used cover glass

for mounting (Figure 2). (2) In our experience, the use of spacers is necessary to limit the

compression of nuclei by the coverslips being pulled by capillary forces (Figure 2). (3) For high-

est possible resolution, we have used an oil-immersion lens.

Part 3: Confocal microscopy

Timing: 45 - 60 m

Part 3 of this protocol describes the procedure for imaging and quantifying nuclear pores using high

resolution microscopy.

Note: This protocol utilizes Nikon equipment and software. Confocal microscopes from other

manufacturers will enable the same experiments with minimal modifications of this protocol.

We provide details of the hardware and terminology used, which should help identify corre-

sponding equipment from other vendors.

22. Whole cell imaging.

Figure 1. Prepare fixed cells for imaging

(A) Remove coverslip with fixed cells from a 24 well plate.

(B) Coverslip with fixed cells facing up (red arrow) placed on microscope slide with spacers consisting of 2 strips of

parafilm used to prevent cells from being flattened.

(C) Add one drop of mounting media (red arrow) to the middle of the round coverslip containing fixed cells.

(D) Cover with a 22 mm 3 22 mm glass coverslip #1.5.

(E) Seal all four edges of the square coverslip with nail polish.

(F) Slide is completely sealed with nail polish and ready for imaging.
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a. Place slide containing mounted cells onto the stage of the confocal microscope. The slide

should be placed so that the glass coverslip is facing toward the objective. (Figure 2).

b. Using the DAPI channel, locate cell nuclei under the 103 or 203 objective lens.

i. Switch to the Plan Apo Lambda 1003 oil immersion objective lens.

ii. Add 1 drop of Immersion Oil Type B to the surface of the lens.

iii. Identify cells with smooth nuclear border by bringing the edge of the nucleus into focus.

CRITICAL: Only select cells with smooth nuclear border in interphase where the entire

nuclear envelope can be seen as a disc. Cells undergoing mitosis should be avoided due

to the breakdown of the nuclear envelope.

c. Once a cell has been selected, set the pinhole size to 0.7AU.

i. Set scanning format size to 1024 3 1024 pixel with a pixel dwell time of 1.1 msec.

ii. Press the SCAN button to begin scanning.

Note: See Image Acquisition Parameters (Table 1) for suggested settings.

d. Adjust the laser power and gain at the optimal focal plane for each subcellular structure (nu-

cleus, nuclear pores, etc). Modify the focus as needed.

CRITICAL: Avoid oversaturation (Figure 4A).

Note: Laser power and gain settings for each channel may vary on different systems and with

individual users. The overall principal is to avoid over oversaturation.

Note: Because it is important to use the full dynamic range of the detector, it is recommended

to evaluate the Look Up Table (LUT) histogram for appropriate display of low through high

range of intensity (Figure 4B).

e. Take an image of the cell of interest by selectingCAPTURE. The captured image will appear with

all fluorophores overlayed. Save both the ND file, the captured raw data containing separate

channel images for each fluorophore, and a TIFF file representing all fluorophores (Figure 3).

Note: Terminology or directions for collecting images may vary on different systems.

23. Nucleus and Nuclear Pore Imaging.

a. Select SCAN again and crop the image so the nucleus engulfs the entire scanning field while

leaving room to visualize the entire nuclear envelope and surrounding nuclear pores (Fig-

ures 4 and 5).

Note: Use the crop function rather than optical zoom to avoid changing the pixel size

Figure 2. Cross-sectional diagram of sample mount

This protocol for heart muscle cells uses an inverted microscope with a Nikon 1003 Plan Apo, Lambda, oil 0.13 mm

working distance lens.
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b. Adjust the pinhole size to 0.4 AU to decrease the amount of scattered light and increase the

resolution to enhance the definition of the nuclear pores.

i. Set the scanning format size to 2048 3 2048 pixel with a pixel dwell time of 3.2 msec.

Note: See Image Acquisition Parameters (Table 1) for suggested settings.

Note: After decreasing the pinhole size, re-adjust the laser power and gain as needed for each

laser to increase the brightness of the subcellular structures. Once the changes have been

made, maintain the parameters for all similar acquisitions.

CRITICAL: Avoid oversaturation (Figure 4).

c. Once the pinhole has been adjusted to 0.4AU and the laser power and gain have been estab-

lished, obtain a 3D image using the Z-series Acquisition on Nikon Elements software.

i. Select the Acquisition tab and click the Z-stack box.

ii. Set the Z range by setting the top and bottom positions of the nucleus.

iii. Focus on the top of the nucleus and press the Top button.

iv. Move the focus to the bottom of the nucleus and press the Bottom button.

v. Set the Z-step size to 0.3 mm to cover the entire depth of the nucleus.

vi. Select Run Now. Save image as an ND file. (Figure 5)

Note: Terminology or directions for collecting images may vary on different systems.

Note: In this protocol, we have used a z-step size of 0.3.mm.Using the formula for z-axis resolution

of a confocal light path : rz = 1:4nl
NA2 for determining the optical resolution limit in z-axis, we calcu-

lated that the combined refractive index of cover glass and glycerol-based mounting medium

of approximately 1.45, an emission peak wavelength of 525 nm for Alexa 488, and a numerical

aperture (NA) of the objective lens of 1.45 yields a z-axis resolution of 507 nm. As such, this pro-

tocol oversamples in z-axis. Users who are interested in reducingmicroscope time for acquisition

could use a wider step size in z-axis as appropriate for their equipment.

Table 1. Image acquisition parameters

Acquisition setup Settings for Whole cell Imaging Settings for imaging Nucleus

Acquisition Mode Laser scanning confocal Laser scanning confocal

Scan Mechanism Galvano Galavano

Line Averaging 0 0

Pinhole 0.7AU 0.4AU

405 nm (DAPI) Emission 450 Emission 450/50 nm

Laser Power 3% 3%

GAIN 96 106

OFFSET 0 0

488 nm (FITC) Emission 525 Emission 525/50 nm

Laser Power 1% 1%

GAIN 37 47

OFFSET 0 0

640 nm (CY5) Emission 700 Emission 685/70 nm

Laser Power 3% 3%

GAIN 90 98

OFFSET 0 0

Pixels 1024 3 1024 2048 3 2048

Pixel dwell time 1.1 msec 3.2 msec

Pixel size 0.08 mm/px 0.04 mm/pixel

Image Size 1024 3 1024 368 3 368

Z-stack step size NA 0.3 mm
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24. 3D data analysis using Nikon Elements software.

Note: This protocol uses Nikon Elements software to quantify nuclear pore complexes. How-

ever, several open-source software options are available which can be used. Steps using Fiji

(ImageJ) are outlined in Step 25.

a. Define Binary Threshold.

i. Convert 3DZ-stackNDfile toaMax (maximum) Intensity Projection image (Figures6Aand6B).

ii. Right click in the Max Intensity Projection image and select New Document (Figures 6C

and 6D).

iii. Using the New Document image (Figure 6D), obtain binary threshold under the DAPI

channel. Click within the nucleus in several areas. Be sure to select both light and dark re-

gions (Figures 6E and 6G).

iv. Define parameters in thresholding dialogue box to determine binary (Figures 6F,6H, and 6I).

b. Convert Binary to ROI.

i. Select the ROI tab located on the tool bar above the image (Figure 7A).

ii. Select Move Binary to ROI (Figure 7A).

iii. Right click within the ROI. Select Copy ROI (Figure 7B).

iv. Paste ROI into the ORIGINAL Z-Stack image (Figures 7C and 7D).

CRITICAL: Do not paste ROI in Max Intensity Projection image. Max Intensity Projection im-

age will not allow for scrolling through the optical sections taken in the Z-stack in step 23c.

c. Select proper Z-stack optical sections for quantification.

i. In the Z-Stack image, choose the top and bottom sections of the nucleus showing pores

on the surface and along the edge of the nuclear envelope (NE) (Figures 9A and 9B).

Figure 3. Neonatal rat cardiomyocyte imaged on high resolution with a Plan Apo Lambda 1003 oil lens objective

using Nikon A1R scanning laser confocal microscope

Scale bar 10 mm.
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CRITICAL: Do not select optical sections that show only the edge of the NE or those that

exclude the edge of the NE (Figures 8A and 8B).

ii. Under the Binary tab located on the tool bar, select Spot Detection -> Bright Spots ->

Bright and Clustered (Figure 9C).

iii. Select the channel used to stain the pores and set parameters to identify nuclear pores.

(Figure 9E).

iv. 1px.

v. Diameter 0.19 mm.

vi. Contrast �17.

vii. Object symmetry = all.

viii. Check Remove dark objects.

ix. Check Apply to all frames.

x. Check Preview.

xi. Select either the top or bottom section of the nucleus to begin the quantification.

(Figures 9A and 9B).

xi. Adjust remove dark objects in the spot detection dialogue box iteratively until there is an

appropriate optimum of included and excluded objects (Figure 9E).

d. Quantification of Nuclear Pores.

i. Once the parameters have been defined in the spot detection dialogue box, hit OK

(Figures 9D and 9E).

ii. Open Automated Measurement Result under the Analysis tab in the tool bar.

iii. Select ROI DATA in the first drop down box, indicated by a yellow arrow in Figure 10C.

iv. Select ROI AREA in the second drop down box, indicated by a white arrow in Figure 10C.

v. Hit the refresh button, indicated by the top red arrow in Figure 10C. This will give the

number of nuclear pores along with the ROI area for that section.

vi. Export data to Excel. Data will include the number of pores as well as the ROI area.

Figure 4. Examples of oversaturation

(A) Oversaturated single plane photomicrograph of nuclear pores. Look Up Table (LUT) histogram showing saturation

exceeding 80–90% of pixel gray value. Scale bar 2 mm.

(B) Appropriately saturated single plane photomicrograph of nuclear pores. Look Up Table (LUT) histogram showing

saturation within 80–90% of pixel gray value. Scale bar 2 mm.
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vii. Without changing any settings, scroll down to the other optical section (top or bottom)

and hit the refresh button again (Figure 10C). The number of pores will be updated.

viii. Export data.

ix. To calculate the total number of pores for the nucleus, add the two numbers. For area

density, divide the total number of pores by the area of the ROI (nucleus) (Figure 10C).

25. 3D data analysis using Fiji (image J).

Note: Here we outline steps to quantify nuclear pores using Fiji (Image J) with and without the

utilization of Gaussian Blur to reduce image noise:

a. Quantification steps using Gaussian Blur (Figures 11A–11E):

i. Load raw data file into ImageJ.

ii. Create 2 duplicates of the of the original file for the channel used to detect nuclear

pores and name as 1 and 2.

Figure 5. Acquiring Z-stack image Next step of appropriately saturated nucleus in Figure 4B

(A) Screen shot of the ND Acquisition window to demonstrate setting z-stack parameters.

(B) Z-stack ND file image of neonatal rat cardiomyocyte acquired using Plan Apo Lambda 1003 oil 1.45NA, 0.133 mm

lens objective. Scale bar 2 mm.

(C) 2D Max projection image of scanned nucleus showing merged image along with separate channels. Scale bar

2 mm.

(D) Look Up Table (LUT) indicating appropriate saturation levels.
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iii. Threshold on the DAPI channel to create an ROI of the nucleus.

iv. Create ROI: Edit -> selection ->create selection.

v. Copy ROI to both duplicates.

vi. Create a Gaussian Blur on each of the duplicates. Process ->Filter -> Gaussian Blur.

vii. For Image 2 use a Sigma (radius) of 2. For Image 1 use a Sigma (radius) of 1.

viii. Find the Difference of Gaussians (DoG) by subtracting image 2 from image 1.

ix. Process -> Image Calculator.

x. Choose ‘‘1’’ as image 1 and ‘‘2’’ as image 2.

xi. Operation = subtract.

xii. Create new window.

xiii. Adjust brightness and contrast.

xiv. Threshold the nuclear pores on the DoG image.

Figure 6. Obtain max projection and define binary

(A) Z-stack image of nucleus. Red arrow indicates tab used to obtain a max projection image Scale bar 2 mm.

(B) Max projection image of nucleus. Scale bar 2 mm.

(C) Max projection image of nucleus. Red arrow indicates drop down box used to ‘‘create new document’’ to define

binary threshold. Scale bar 2 mm.

(D) New document used to define threshold Scale bar 2 mm.

(E) Select DAPI Channel under New Document used to define binary.

(F) Screen shot of the dialogue box for defining binary threshold parameters.

(G–I) (G) Select area of contrast to define binary (H) Thresholding after binary threshold is defined (I) Final Threshold

after additional parameters are adjusted, including Smooth, Clean, Fill holes, Separate.
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xv. Separate particles: Process -> Binary ->Watershed.

xvi. If needed, remove errant particles. Process -> Binary -> Open.

xvii. Set size measurements. Analyze ->Set measurement.

Check Limit Threshold box.

Check Bounding rectangle box to count particles within the ROI only.

xviii. Count Pores.

xix. Analyze ->Analyze particles.

Set size parameters and additional outputs needed.

Hit OK. Summary will show total number as well as other overall measurements.

b. Quantification Steps without the use of Gaussian Blur (Figures 11F–11I):

i. Load raw data file into image J.

ii. Threshold on the DAPI channel to create an ROI of the nucleus.

iii. Binary -> open.

iv. Edit -> selection -> create selection for ROI.

v. Copy ROI.

vi. Adjust brightness and contrast.

vii. Threshold the nuclear pores.

viii. Separate particles: Process -> Binary -> Watershed.

ix. Set size measurement: Analyze -> Set measurement.

x. Check Limit Threshold box.

xi. Check Bounding rectangle box to count particles within the ROI only.

xii. Count pores.

xiii. Analyze -> Analyze particles.

Figure 7. Convert Binary to ROI

(A) Image of final binary threshold. Red arrow indicates the dropdown box used to Move binary to ROI.

(B) Image of binary converted to ROI. Red arrow indicates selection of ROI in dropdown box.

(C) Original Z-stack image. Red arrow indicates the dropdown box used to Paste ROI from thresholding.

(D) Original Z-stack image showing ROI which will be used for nuclear pore quantification. Scale bar 2 mm.
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Set size parameters and additional outputs needed.

Hit ok. Summary will show total number as well as other overall measurements.

EXPECTED OUTCOMES

This protocol could be used on different cell types for detecting and quantifying nuclear pores along

the nuclear envelope. This protocol shows that cardiomyocyte nuclei have 1,856 G 66 in fetal

(E14.5), 1,040G 53 in neonatal (P2), and 678G 32 in adult (P60) rat hearts (meanG SEM, ref. 1. How-

ever, the number of nuclear pore complexes varies widely between cell types and growth condi-

tions,6,7 and, consequently, the quantification may yield different results in other cell types.

LIMITATIONS

This protocol outlines a reproducible approach for quantifying pores in the nuclear envelope. The pores

are quantified by obtaining 3D z-stack images and compressing them into 2Dmaximal intensity images.

This allows for the pores to be quantified along the nuclear surface and edgewithin the same optical sec-

tion. However, this may cause the software to pick-up small background signals and include them as part

of the quantification. In addition, nuclear pore complexes are made up of approximately 30 different nu-

cleoporins which gives it the cylindrical structure of eight spokes surrounding a central tube. Since this

protocol is used to detect only certain nucleoporins, the structure or the transport activity of the pore

cannot be determined. It should be emphasized that this protocol assumes that nuclei have the shape

of a flat cylinder and quantifies the nuclear pore complexes of the parallel surfaces while neglecting

the mantle surface. This should be considered when this protocol is used for nuclei with a round or irreg-

ular shape. Moreover, this protocol relies on the quality of the antibodies to detect nuclear pores. Non-

specific binding or weak binding could yield false positive or false negative counts of the nuclear pores,

respectively. It is, however, worth noting that the quantitative results of nuclear pore numbers in cardio-

myocytes using this protocol and antibody (Mab414), were cross validatedwith StochasticOptical Recon-

struction Microscopy (STORM) and freeze fracture replica electron microscopy (EM), as published.1 Ap-

plications in other cell types should consider similar cross validations.

TROUBLESHOOTING

Problem 1

Low or no signal (related to steps 22 and 23; Figure 12).

Potential solution

� Be sure that cells have not been kept in storage for a long period of time prior to staining.

� Use newly purchased antibody and aliquot to avoid freeze/thaw cycles. Using an antibody that is

old or has been through multiple freeze/thaw cycles will decrease the signal.

� Use correct antibody dilution. Follow vendor’s recommendation and increase concentration if the

age and status of the antibody is unknown (for example, From 1:400 to 1:200).

Figure 8. Identify correct Z-stack optical sections for counting nuclear pores

(A) Optical section in Z-stack showing nuclear pores only on the surface of the nuclear envelope. Scale bar 2 mm.

(B) Optical section in Z-stack showing nuclear pores only along the edge of the nuclear envelope. Scale bar 2 mm.

(C) Optical section in Z-stack showing nuclear pores along the edge and surface of the nuclear envelope. Scale bar 2 mm.
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� Be sure that incubation of the secondary antibody is done in complete darkness.

� Check to ensure that the secondary antibody used matches the host of the primary antibody.

� Image cells within a day or two of staining to prevent the signal from fading.

Potential problem 2

High background (related to step 22 and 23; Figure 13).

Potential solution

� Rocking the plate during each wash step will ensure removal of any excess fixative, primary and

secondary antibody solutions as well as any loosely bound antibody.

� Be sure to use fresh fixative. Old or expired formaldehyde may cause autofluorescence.

� Change secondary antibody to one that is known to have less background (i.e., Alexa Fluor 594).

� Decrease pinhole to reduce amount of scattered light.

� Decrease density of cells plated to prevent overlapping.

Figure 9. Identify nuclear pores stained with Mab414 using spot detection with Nikon Elements Software

(A) Lowest optical section in Z-stack, indicated by red arrow, used for counting nuclear pores along the edge and

surface of the nuclear envelope. Scale bar 2 mm.

(B) Highest optical section in Z-stack, indicated by red arrow, used for counting nuclear pores along the edge and

surface of the nuclear envelope. Scale bar 2 mm.

(C) Original z-stack image. Red arrows indicate spot detection and bright spots located under the Binary tab. Scale bar 2 mm.

(D) Nuclear pores detected by spot detection prior to parameters adjustment. Scale bar 2 mm.

(E) Zoomed-in screen shot of Spot Detection box used to set parameters for selecting nuclear pores to be counted.
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Problem 3

Over selection of bright spots by software (related to step 24c; Figure 14).

Potential solution

Adjust parameters in spot detection dialogue box, i.e., contrast and remove dark spot.

Problem 4

Decreased or non-attachment of cells (related to Part 1).

Potential solution

� Check for bacterial contamination.

� Check preparation and coating conditions of Fibronectin

� Test different extra cellular matrix for coating coverslips prior to plating (for example: Collagen,

Laminin, or Gelatin). Other cell types may require a different matrix. Prepare and coat according

to manufacturer’s recommendations.

Problem 5

During imaging, cells do not come into focus or remain in focus (related to step 22 a and b).

Potential solution

� Check to confirm that the coverslip was not flipped duringmounting so that the cells are facing the

slide and not the No. 1.5 cover glass (steps 18 and 19)

Figure 10. Quantification of nuclear pores stained with Mab414

(A) Nuclear pore quantification on the lowest optical section in the Z-stack showing pores along the edge and surface

of the nuclear envelope. Scale bar 2 mm.

(B) Nuclear pore quantification on the highest optical section in the Z-stack showing pores along the edge and surface

of the nuclear envelope. Scale bar 2 mm.

(C) Screen shot image of Automated Measurement Results dialogue box. Yellow arrow indicates ‘‘ROI Data’’ drop

down box; white arrow, ‘‘ROI Area’’ drop down box; red arrows, Number of Objects (nuclear pore count), ROI Area,

and refresh button used to obtain counts from both sections.
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Figure 11. Quantification of nuclear pores stained with Mab414 using Fiji/ImageJ

(A–I) Workflow for quantification with (A–E) and without (F–I) Gaussian blurring. (A) DNA staining with Hoechst to

delineate the boundaries of the nucleus. (B) Use of Gaussian Blur on photomicrograph of nuclear pores stained with

Mab414 with sigma radius of 1 (left panel) and 2 (right panel). (C) Difference of Gaussians (DoG): Subtraction of

photomicrograph 2 (sigma 2) from photomicrograph 1 (sigma 1). (D) Thresholding and binary on nuclear pore complex

image. (E) Digital quantification yields nuclear pore count of 261. (F) DNA staining with Hoechst to delineate the

boundaries of the nucleus. (G) Photomicrograph of nuclear pores stained with Mab414. (H) Thresholding and binary

on nuclear pore complex image. (I) Digital quantification yields nuclear pore count of 369.
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� Checked to be sure that the No. 1.5 glass coverslip is sitting evenly on top of the parafilm spacers

and plastic Thermanox coverslip (steps 20 and 21)

� Check that enough oil has been placed on the objective so that it spreads evenly once the objec-

tive has come into contact with the glass coverslip,

RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-

filled by the lead contact, Bernhard Kuhn: bernhard.kuhn2@chp.edu.

Materials availability

This study did not generate new unique reagents.

Data and code availability

This study did not generate any data sets or codes.

Figure 12. High resolution image of nuclear pores

stained with Mab NUP 153

Induced pluripotent stem cell cardiomyocytes (ips-

cm’s) acquired using Plan Apo Lambda 1003 oil

1.45NA, 0.13 mm objective lens. Red arrows indicate

high nuclear pore antibody signal. Yellow arrows

indicate low nuclear pore antibody signal. Scale bar

10 mm.

Figure 13. Zoomed in high resolution image of

nuclear pores stained with Mab NUP 153

Mouse cardiomyocyte nucleus acquired using Plan

Apo Lambda 1003 oil 1.45NA, 0.13 mm objective lens

showing high background staining. Scale bar 5 mm.
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